
Release – 1.14.0 (Major Version) 

Release Date: 31.12.2022 

In this article, you will learn which 

• new features are available, 

• improvements were implemented for users and 

• which bugs have been fixed in version 1.14.0 of the Workflow. 

This Article can also be downloaded as a PDF version. The release notes for the previously released 

versions can be downloaded from the Archive. 

1. Overview 

With version 1.14.0, users can take advantage of several innovations in the environment of Variable Data, 

Verification, and Grid Charts. In addition, improvements have been made to check-in and the management of Print 

Data, and further translations have been made. 

Please find below an overview of all changes. A detailed description follows in the sections on innovations, 

improvements, as well as bug fixes. 

Before the update 

• One day before the update to version 1.14.0 the routine "Cleanup Log Tables" should be executed. 

Otherwise the update may take an unusually long time. 

• PrintFactory must be started when updating to version 1.14.0 if you are running a third-party 

printer from the Workflow. 

• The installation setup of version 1.14.0.(752) - or higher - must be installed. 
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1.1. New features 

The following new features are available in version 1.14.0 of the Workflow: 

VDP Editor: Since version 1.12.0, the VDP Editor for creating and managing variable data in the browser is available 

in the Workflow. In version 1.14.0, further innovations and improvements have been implemented: 

• General – General improvements have been developed in version 1.14.0. On the one hand, the placement of text 

elements has been completely reworked. On the other hand, the possibility of multiple selections of VDP 

elements has been implemented and numerous shortcuts, translations, and symbols have been added. 

• New functions – Starting from this version, additional functions such as align, copy, paste and reset are 

available. 

• Improvements of existing functions – Existing functions and tools have been enhanced and improved, 

especially with regard to user guidance. 

Verification of a Color Policy: In this version, the Verifications section has been created in the Workflow. There, the 

user can verify a Color Policy against the FOGRA and G7 standards. Furthermore, the user can check the production 

run or the print between printing systems in relation to stability and comparability. 

Installing an update for versions higher than 1.14.0 

Workflow versions 1.14.1, 1.14.2, and 1.15.0 and all future versions can only be installed if Workflow 

version 1.14.0 was installed before. Thus, an update from an earlier version e.g.: 1.11.x, 1.12.x as 

well as 1.13.x cannot be performed! The reason for this was internal improvements in the migration 

logic introduced in version 1.14.0. Before future updates, make sure that version 1.14.0 has already 

been installed. 

An update from the Workflow version smaller than 1.11.0 to version 1.14.0 and higher must first be 

updated to version 1.11.0 and only then to 1.14.0! 

The following SDK versions are used in DW 1.14.0: 

• Callas Software pdfToolbox 14.0 

• Callas Software pdfChip 2.4.072 

• Color Logic CrossXColor 1.20.1.44435 

• Global Graphics HHR 13.2.2 
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Grid Charts: In this release, two additional Grid Chart types have been developed which can be generated and 

printed in the Workflow. These are: 

• Grid Chart of Tonal Values – It is now possible to create or print a Grid Chart of a selected Spot Color with 1% 

graded Tonal Values. Thereby, among other things, it is possible to determine the maximum density which is to 

be used for white. Afterward, use the Fixup "Change Tonal Value of a Spot Color" to optimize the Print Item 

before Output and thus save ink. 

• Grid Chart of overprinting Spot Colors – The ability to create and print a Grid Chart of two overprinting Spot 

Colors has been added. This allows the visual appearance of overprinting Spot Colors to be checked in graded 

Tonal Values. 

Check-in Templates: In this release, the options in the Check-in profile have been further expanded. Furthermore, 

the availability of check-in templates was made provided system-wide. The following areas are affected: 

• System-wide settings – For version 1.14.0, the area for managing check-in templates has been modified to 

meet the needs of Workflow administrators. 

• Force Print – Starting with this release, check-in templates are also available in Force Print. 

• Hotfolder – Starting from this version, check-in templates are also available in the Hotfolder. 

• New options – With version 1.14.0 more options for Checks as well as Fixups have been implemented. 

Approval Reports: As of this version, Approval Reports as well as project Print Itemations can be named 

automatically based on a defined naming scheme. In addition, filtering and sorting options have been implemented 

in the online Approval Portal. 

• Name of the Approval Report – As of this version, a system setting is available for naming the Approval Report. 

The project name and the file name can be freely defined. However, when creating the report, the setting can be 

additionally overwritten. 

• Filter and sort in Approval Portal – Starting from this version, two additional filter and sort options - by name 

and by status - are available in the Approval Portal. 

User-defined fields: With version 1.14.0, the user-defined fields for Print Items and Articles have been merged to 

prevent conflicts when transferring user-defined fields to a Production Job. 

Data Preparation: Further Fixups were added or improved. In addition, existing Fixups were extended in 

functionality or improved with regard to usability, and the conversion of Fixups with dynamic fields was further 

advanced. 

SDK versions: Updates from various OEM partners, among others, also provide for further innovations and 

improvements. Version 1.14.0 includes the Callas Software pdfToolBox version 14.0 and the Color Logic 

CrossXColor SDK version 1.20.1. 
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1.2. Improvements 

"Variable Data" tab: Also in this version changes have been made in the "Variable data" tab. These are: 

• Display of warnings and errors – Warnings and errors, which are displayed in the VDP Editor, are also displayed 

in the "Variable Data" tab from this version onwards so that they are also clearly visible outside the VDP Editor. 

• Warning when importing VDP settings – When importing VDP settings, the system checks whether the 

dimensions of the Print Item differ from the original Print Item. If the dimensions do not match, a warning is 

displayed in this tab. 

Adaption of the user interface in Output Templates: In this version, the user interface for creating a Simulation or a 

Proof has been adapted to make the selection more intuitive for the user. 

Filter possibilities for the "Print Statistics" tab: In the course of the development of the version, more filtering 

options for the list of Print Statistics have been added. 

Permissions: In this version, some permissions were adapted. 

Rest API: The possibility to control Check-in Templates via the API has been added. It is also possible to overwrite 

dynamic variables in Fixups. 

Small Improvements: Further small improvements were implemented. 

1.3. Fixed Bugs 

Workflow: List of fixed bugs or minor improvements in the main application. 

Impose Editor: List of fixed bugs and minor improvements in the Impose Editor. 

VDP Editor: List of fixed bugs or minor improvements in the VDP Editor. 

2. Improvements 

In this section, you will learn which new features have been implemented in the VDP Editor, the Impose Editor, and 

the Workflow. In some cases, already existing functions have been extended. 
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2.1. VDP Editor 

The VDP Editor for creating and outputting variable data in the browser is available since version 1.12.0 of the 

Workflow. In version 1.14.0, more new features and enhancements that should make it easier to move from Adobe 

Illustrator to the browser version have been implemented. Learn more in this section. 

2.1.1. General 

General improvements have been implemented in this version. Some implementations are described below. 

Handling VDP Texts 

Up to now, a text frame, which was also responsible for positioning the variable text, was created around the VDP 

text. From this version on, only the baseline on which the variable text is positioned is displayed. This means that 

the position of the text can be controlled precisely via the X and Y position in the Transform tab. 

Figure 1: Left: Selected text before version 1.14.0; Right: Selected text from version 1.14.0 

Multiple selection of VDP elements 

For the function of aligning and distributing described in 2.1.2 to work, the restriction that only one VDP element 

could be selected at a time had to be removed first. With version 1.14.0, multiple VDP elements can now be 

selected and modified. 

Keyboard shortcuts 

In the course of development, many keyboard shortcuts have been introduced for the VDP Editor to ensure that the 

user can work with the VDP Editor with ease. 

Figure 2: Overview of the keyboard shortcuts in the VDP Editor 
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Function macOS Windows 

Tool Bar 

Selection Tool V V 

Direct Selection Tool A A 

Text Tool T T 

Image Tool F F 

Barcode Tool B B 

Rectangle Tool R R 

Edit Path Tool P P 

Scissor Tool S S 

Measure Tool M M 

Hand Tool G G 

Zoom Tool Z Z 

Fit to Width W W 

Fit to Height H H 

Drawing Aid 

Move the VDP element horizontally 

or vertically 
Move with Shift Move with Shift 

Duplicate VDP element option + Move alt + Move 

Draw a circle or square with Bis, 

Barcode, Ellipse, and Rectangle tool 
Drag with Shift Drag with Shift 

Raise a VDP element from the 

center 
option + Drag alt + Drag 
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Function macOS Windows 

Increase the number of sides/

peaks for polygon/star 

Press the right arrow key when 

dragging 

Press the right arrow key when 

dragging 

Reduce the number of sides/peaks 

for polygon/star 

Press the left arrow key when 

dragging 

Press the left arrow key when 

dragging 

Enlarge star shape 
Press the upwards arrow key when 

dragging 

Press the upwards arrow key when 

dragging 

Reduce star shape 
Press the downwards arrow key 

when dragging 

Press the downwards arrow key 

when dragging 

General keyboard shortcuts 

Crop cmd + X strg + X 

Copy cmd + C strg + C 

Paste cmd + V strg + V 

Paste at the original position cmd + Shift + V strg + Shift + V 

Select all VDP elements of a VDP 

layer 
cmd + A strg + A 

Consecutively select several VDP 

elements 
Selection Tool + Shift Selection Tool + Shift 

Delete VDP element Remove key Delete key 

User interface 

In the course of development, the user interface was expanded with new functions and existing functions were 

supplemented by better terms with additional help. All new functions are described below in 2.1.2 New functions. In 

addition, the following helpful enhancements were implemented. 

Help on Truncate String function: Addition of help texts describing what various entries in the input fields do. 

Figure 3: The Truncate String function from the content tab 
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Increased scope of errors and warnings: The number of error and warning messages has been greatly expanded to 

avoid major surprises in production. 

Figure 4: The Errors and Warnings dialog displays more errors and warnings than were displayed in earlier versions 

Improved support to values in barcodes / QR codes: Display of values that are allowed to be used, making it easier 

for the user to troubleshoot why the barcode is not generated. 

Figure 5: Display of the possible values for the selected barcode in the help note 
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Guides 

The handling of guidelines has been simplified. From this version onwards, a guide can be subsequently removed 

by moving it to the ruler's origin. 

2.1.2. New Functions 

For version 1.14.0 new functions have been developed, which can be used to create and edit variable elements. The 

following new features have been implemented. 

Align and Distribute function 

As of this version, additional options are available in the Transform settings area of the Transform & General 

Settings tab. The functionality of the Align and Distribute options are already known from the Impose Editor and 

can also be used in the VDP Editor as of this version. Proceed as follows: 

1. Open the VDP Editor. 

2. Create multiple variable elements using the Text, Image, Barcode, or Rectangle Tool. 

3. Select the VDP elements on the artboard that you want to align or distribute. 

4. Activate the Transform & General Settings tab. 

5. Select the desired function in the Transformsettings area: 

• Align [1]– determine in this area how the element or elements should be aligned: 

• Align left: All selected objects will be aligned with the object farthest to the left. 

• Align horizontally centered: All selected objects are aligned to the horizontal center of the selection. 

• Align right: All selected objects are aligned to the object farthest to the right. 

• Align top: All selected objects are aligned to the object that is farthest up. 

• Align vertically centered: All selected objects are aligned to the vertical center of the selection. 

• Align bottom: All selected objects are aligned to the object that is farthest down. 
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• Origin [2] – determine the origin of the position alignment of the function which was selected in Align. Four 

options are available: 

• Align to Selection:  The reference point represents the sum of the selected objects. The procedures 

described in Align are based on this selected origin. 

• Align to Sheet: The reference point represents the edges of the displayed Print Item. Note that this will 

very quickly position VDP elements outside the printable area, resulting in a warning message in the VDP 

Editor. 

• Custom: The reference point represents a virtual rectangle, which you can specify by entering the X and Y 

coordinates as well as the width and height. By clicking on the eye icon [5], this reference rectangle is 

displayed on the Print Item. 

• ImageBox: The reference point represents the ImageBox selected for the Print Item. 

• Distribute [3] –  determine whether the selected objects are to be distributed horizontally or vertically. A 

distance can also be used for this purpose. You can enter the desired spacing if you activate the Use 

Spacing checkbox [4]. 

Figure 6: The Align and Distribute function in the VDP Editor 

Blend Modes for variable images 

Blend Modes can be applied to entire objects or their individual parts and entire object groups. Behind each Blend 

Mode, there is a defined calculation method. As of version 1.14.0, these already-known Blend Modes can also be 

applied to variable images. You can learn more about the Blend Modes here. 
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Reset Polygon Tool Settings 

Since version 1.13.2, the two tools - Polygon and Text Polygon Tool - are available in the VDP Editor. You can click 

and drag to draw a polygon. By default, the polygon created with this tool has five corners with five edges. It is 

possible to change the number of corners and edges of a polygon by pressing the arrow keys while dragging the 

polygon. 

To reset these settings - how many corners and edges the polygon should have - a new function Reset Polygon Tool 

settings to default [6] has been added in this version. This option is available in the toolbar as an extended menu. 

By activating this function, the default polygon with five corners and five edges is restored. 

Figure 7: The toolbar of the VDP Editor with the possibility to reset the Polygon or Reset Text Polygon Tool Settings 

to default 

Stroke/Gap Definition 

Starting from this version, dashed lines can be created in the VDP Editor. This function can be used for all Object 

Creation Tools as well as Text Tools. Proceed as follows. 

1. Open the VDP Editor. 

2. Use the toolbar to create the desired VDP elements. 
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3. Select a VDP element on the drawing area. 

4. Activate the Format tab. 

5. Depending on whether you have used a VDP text element or an Object Creation Tool, you can determine how the 

dashed line should be constructed in either the Font Settings or Path Settings panel. 

• Line thickness [7] [12]: Use this to determine the contour thickness of the dashed contour. 

• Stroke [8] [11]: Determine how long the contour to be drawn should be. 

• Gap [10] [14]: Use this to determine how long the non-drawing contour should be. 

• Irregular dashed line: If you want to create an irregular dashed line, you must add another stroke/gap 

segment [9] [13] and enter the corresponding values. 

6. Determine the length of the drawing contour and the length of the non-drawing contour. By entering the same 

value for the stroke and for the gap, a regular dashed line will be created. If you want to make the pattern more 

variable, you have to add another definition for stroke and gap by clicking on the + symbol. 

Figure 8: The setting areas Path Settings as well as Font Settings for defining dashed lines 

Cut, copy and paste 

Since version 1.14.0 the following new options are available in the VDP Editor action menu in Edit: 

• Cut - copies the selected elements to the clipboard and removes them from the drawing area. 

• Copy - copies the selected elements to the clipboard. 
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• Paste - pastes the elements in the clipboard centered in the current drawing area section. 

• Paste to original position - pastes the elements in the clipboard to the original position. 

Figure 9: The Edit menu of the Actions menu of the VDP Editor 

2.1.3. Improvements of existing functions 

Also in this version already existing functions have been extended or improved. Improvements have been 

implemented in the editing of Bezier curves or paths and the multiple selection of VDP elements by pressing the 

Shift  key has been added. 

The following improvements have been implemented when editing curves or paths: 

• When you place the mouse pointer over a path point with the Edit Path Tool selected, a minus symbol is added 

to the cursor. Thereby, you can delete the path point. 

• When you place the mouse pointer over a path with the Edit Path Tool selected, a plus symbol is added to the 

cursor. Thereby, you can insert an additional path point. 

• When you have the Edit Path Tool selected and place the cursor over a path point while pressing the command 

or ctrl key, the cursor will change to the Direct Selection Tool. Use this tool to move a path point. 

• When you have selected the Direct Selection Tool, you can select a path point. Clicking on another path point 

deselects all selected path points and selects the last selected path point. 

• Pressing the Shift  key and clicking on the next path point will add the path point to the selection. 

• Pressing the option  or alt  key and clicking on the next path point will select all path points on the current 

path. 

• The Scissors Tool can be used to cut the path at any path point and at any position on the path. 
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2.2. Verifications 

With version 1.14.0, the new Verifications section has been created in the Workflow in the Color menu item. 

Therein, the user will be able to perform Fogra and G7 Verifications as well as comparative measurements of 

printed Sheets in production or between printing systems.  

This creates the possibility in the Workflow to verify the printing system and Substrate combinations against 

international standards. This is necessary to obtain the corresponding certification from official bodies. In addition, 

the Verification tool enables quality managers in companies to check the stability of printing systems against 

company standards. Thereby, it is possible to initiate the appropriate technical steps in good time to bring the 

printing system back within the applicable tolerances. 

Further explanations about the VDP Editor 

In case you want to read more about how to work with the VDP Editor, we recommend reading the 

chapters in the VDP Editor manual. There you can look up how to create serial numbers, variable 

texts, variable images, and variable color areas and how to build a control file to create the variable 

content based on the control file. 

Only available for beta testers 

With version 1.14.0, the entire infrastructure for performing verification was developed just as the 

first two Fogra verification methods ISO 12647-8 (Validation Print 2021) and ISO 12647-7 (Contract 

Proof 2016) were implemented. 

• A complete Fogra verification - including the PSD evaluation verification method - is available as of 

version 1.14.1. 

• G7 Grayscale as well as G7 Targeted verification is available from 1.14.2. 

• The G7 full verification will finally be available in version 1.15.0. 

• Comparison measurements to check the stability of printing systems as well as between printing 

systems will also be available with version 1.15.0 

If you are interested in the beta program, please let us know. We would unlock all beta 

implementations for your license so that you can perform your tests or check the usability of the 

function at an early stage. Please send the mail to info@prepress-digital.com. 
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2.2.1. User interface of the "Verifications" area 

To be able to perform a Verification, you have to select the Color > Verifications menu. The user interface of the 

menu item has four sub-areas. 

• Header [15] - Allows the user to quickly see which menu item is currently selected. 

• Filter and Search Bar [16] - Allows you to filter, search, and sort the list of Verifications. 

• Action bar [17] - Allows you to perform an action on selected Verifications, create a new Verification Job, as well 

as customize the list view to your way of working. 

• Pagination with list display limitation [19] - Allows to limit the list display to a certain number of records and to 

scroll between individual pages. 

• List [18] - List of currently filtered Verifications. 

Figure 10: The user interface of the menu Color > Verifications 

Additional package for Workflow 

Please note that access to the Verifications menu item in the Colors menu will in the future be linked 

to the purchase of an additional package. The additional package enables the user to perform a G7 

verification as well as comparison measurements for a production run or between printing systems. 

If a Fogra verification is to be made in the Workflow, access to it is tied to two conditions: 

• The additional package has been purchased 

• The licensee has concluded a license agreement with Fogra for the use of the Fogra Wedges and 

can present this when ordering. If this proof cannot be provided, the licensee can also order the 

license for the Fogra wedges when purchasing the additional package. 
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2.2.2. Performing a Verification 

If you want to carry out a Verification, you must go through certain steps so that a corresponding report can finally 

be generated and the marking for the selected Color Policy can take place. The following steps must be completed: 

1. Create Verification Job - create a Verification Job in which the Verification type - Fogra, G7, or Compare - as well 

as the matching Color Bar and the Color Policy must be selected. The status is automatically set to "Created" by 

the Workflow. 

2. Print Verification Job - print Verification Job on the appropriate Printer and Substrate, which is the basis of the 

selected Color Policy. The status is automatically set to "Printed" by the Workflow. 

3. Provide measurement data for the Color Bar - the measurement data for the selected Color Bar can either be 

read directly in this step. Furthermore, the measurement data that was measured in with an external application 

can be uploaded. The status is automatically set to "Measured" by the Workflow. 

Further information 

Further information about the user interface can be found in the Article Creating a User Interface 

and Verification. 
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4. Check measurement data for conformity - in this step, the measurement data is compared with underlying 

values/standards, and the corresponding evaluation is calculated for the selected verification method. The 

status is automatically set to "Verified" by the Workflow. 

5. Create Verification report - a Verification report can be created and downloaded to document the result. 

2.3. Grid Chart 

With version 1.14.0, two new Grid Chart types - Grid Chart of Tonal Values and Grid Chart of overprinting Spot 

Colors - are provided. This makes it easier to sample Spot Colors for special applications. 

To create or manage new Grid Charts, you must go to the Color > Color Books and Grid Chart menu. The user 

interface of the Tonal Value/Overprint Grid Charts tab has five sub-areas. 

• Header [19] - allows the user to quickly see which menu item is currently selected. 

• Filter and Search Bar [20] - allows you to filter, search and sort the list of Grid Charts. 

• Action bar [21] - allows you to perform an action on selected Grid Charts, create a new Grid Chart, as well as 

customize the list view to your way of working. 

• Pagination with list display limitation [23]- allows you to limit the list display to a certain number of records as 

well as to scroll between the individual pages. 

• List [22] - list of currently filtered Grid Charts. 

Figure 11: The user interface of the Tonal Value/Overprint Grid Chart tab in the menu item Color > Color Book & Grid 

Charts 

Further information 

Further information on how to perform a Verification as well as detailed documentation on all 

parameters that can be encountered when performing a verification can be found in the Article 

Create User Interface and Verification. 
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2.3.1. Grid Chart of Tonal Values 

The Grid Chart of Tonal Values consists of 100 color patches with graduated Tonal Values from 100% to 1% and a 

gradient from 100% to 1% for the selected Spot Color. There are many uses for a Grid Chart of Tonal Values. For 

more information, see the Article Grid Charts - Introduction. 

Grid Charts related Articles or Print Items 

These new Grid Charts can also be created in the Article or Print Item context. To do this, open an 

Article or Print Item with Spot Colors. Navigate to the Spot Color settings area - select the desired 

Spot Color and subsequently create the desired Grid Chart. 

After creating the Grid Chart, it will then be placed in the Color > Color Books & Grid Charts menu. 

There both new Grid Chart types can be edited, deleted as well as again sent to the Printer. 

Further information 

Find further information on Grid Chart management in the Article User Interface of Grid Chart 

Management. Therein, detailed documentation on all parameters that can be encountered when 

managing Grid Charts is available. 
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Create Grid Chart of Tonal Values 

A Grid Chart of Tonal Values can be created either via the menu item Color > Color Books & Grid Charts Tonal 

Value/Overprint Grid Chart or directly in the detail view of an Article or a Print Item in an Order or Production Job. 

The creation process is always the same, no matter where you started from. You have to go through the following 

steps: 

1. Call up the menu item for creating a Grid Chart of Tonal Values. 

2. Select a Spot Color and name the Grid Chart. 

3. Select the Printer with the appropriate output configuration. 

4. Define the Grid for the layout of the Grid Chart. 

5. Create the Grid Chart to print it later or send it to the selected Printer immediately after creation. 

All you have to do is adjust the options in each step to execute your project. 

Step 1: Create Grid Chart of Tonal Values - General 

1. Enter a name [24] for the Grid Chart to be created. 

2. Select the desired Base Spot Color [25]. Depending on where you started, you will be offered either all system-

wide, Substrate-specific, or custom Spot Colors. Furthermore, Spot Colors from a color library or just the Spot 

Colors of the current Print Item are available. 

3. Select Create [26] if you want to create the Grid Chart without sending it to the Printer. This can also be done 

later in the Color > Color Books & Grid Charts menu item. 

4. Select Next [27] if you want to jump to the next step Output Configuration. 

Figure 12: The first step General when creating a Grid Chart of Tonal Values 

User Manual

Page 19Release – 1.14.0 (Major Version)



Step 2: Create Grid Chart of Tonal Values – Output Configuration 

1. In the Output Configuration step select which Printer with which Output Configuration the Grid Chart will be 

printed. 

• Printer [28] - select the target Printer, limiting the selection in the Substrate option already to the assigned 

Substrates for the Printer. 

• Substrate [29] - select the Substrate to be used in it, thus limiting the selection in the Color Policy option already 

to the available Color Policy for the Substrate. 

• Color Policy [30] - select the Color Policy which is to be used. If you know in advance which Color Policy you 

want to use to print the Grid Chart, select the Color Policy by entering its ID in the selection menu. This 

procedure automatically selects the Printer and Substrate accordingly to the preceding options. How many 

colors the Grid Chart will be printed is shown to the user by the visualization of the Color Channels [31]. 

• Destination folder [32] - select the folder to which the Grid Chart will be rendered to the Printer. 

1. Select Create [33] if you want to create the Grid Chart without transferring it to the Printer. This can also be done 

later in the Color > Color Books & Grid Charts menu item. 

2. Select Next [34] if you want to jump to the next step Layout. 

Figure 13: The second step Output Configuration when creating a Grid Chart of Tonal Values 
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Step 3: Create Grid Chart of Tonal Values - Layout 

1. In the Layout step, determine how the Grid Charts should be arranged to be output to the Printer. 

• Impose Sheet Size [35] - select the size of the Imposition to be created by either selecting the desired 

Substrate Definition or entering a user-defined Impose Sheet size. 

• Substrate Definition [36] - select a desired Substrate Definition. This selection is only available if the Use 

Substrate Definition option is selected. 

• Width and Height [37] - use this to define the size of the Impose Sheet. These options are only available if the 

Custom option has been selected. 

• Alignment [38] - use this to define how the Grid at Grid Charts should be aligned horizontally or vertically on 

the Impose Sheet. 

• Grid settings [39] - define the Grid in which Grid Charts are to be mounted and printed by specifying 

Columns and Rows. 

• Spacing [40] - define the horizontal and vertical spacing between the individual Grid Charts. 

• Rotate [41] - define the rotation in which Grid Charts are to be rotated. 

1. Select Create [42] if you want to create the Grid Chart without sending it to the Printer. This can also be done 

later in the Color > Color Books & Grid Charts menu item. 

2. Select Create and send to Printer [43] to complete the creation process and output the Grid Chart to the Printer. 

Figure 14: The third step Layout when creating a Grid Chart of Tonal Values 
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Further Options 

In addition to creating the Grid Charts, other options are available in the Color > Color Books & Grid Charts > Tonal 

Value/Overprint Grid Charts menu item. These are: 

• Edit - pressing this button reopens the Create dialog. Settings that have already been made can be revised. Only 

the Spot Color itself may not be changed afterward. 

• Delete - using this option, selected Grid Charts can be removed from the system. This operation cannot be 

undone. 

• Send to Printer - pressing this button opens the Create dialog again. After going through the individual steps, the 

Grid Chart can be sent to the Printer. 

• Download - by clicking this button, the Grid Chart will be downloaded locally as a PDF file. 

2.3.2. Grid Chart of overprinting Spot Colors 

The Grid Chart of overprinting Spot Colors consists of a Base Spot Color in the selected hue. Additionally, there are 

100 color patches with graduated Tonal Values from 100% to 1% and a gradient from 100% to 1% for the selected 

overprinting Spot Color. The areas of application for the selection of the Grid Chart of Tonal Values are versatile. For 

further information, please refer to the Article Grid Charts - Introduction. 
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Create an Overprint Grid Chart 

A Grid Chart of overprinting Spot Colors can be created either via the menu item Color > Color Books & Grid Charts 

> Tonal Value/Overprint Grid Chart or directly in the detail view of an Article or a Print Item in an Order or 

Production Job. 

The creation process is always the same, no matter where you started from. You have to go through the following 

steps: 

1. Call up the menu item for creating a Grid Chart of overprinting Spot Colors. 

2. Select a Base Color and a Spot Color to be overprinted and assign the name of the Grid Chart. 

3. Select the Printer with the corresponding Output Configuration. 

4. Define the Grid for the layout of the Grid Chart. 

5. Create the Grid Chart to be printed later or send the Grid Chart to the selected Printer immediately after 

creation. 

Step 1: Create Grid Chart of overprinting Spot Colors - General 

1. Enter a name [44] for the Grid Chart which is to be created. 

2. Select the desired Base Spot Color [45]. Depending on where you started, you will be offered either all system-

wide, Substrate-specific or customer-specific Spot Colors. Additionally, you will be offered Spot Colors from a 

color library or just the Spot Colors of the current Print Item. 

3. Select the desired overprinting Spot Color [46]. Depending on where you started, you will be offered either all 

system-wide, Substrate-specific or customer-specific Spot Colors. Additionally, you will be offered Spot Colors 

from a color library or only the Spot Colors of the current Print Item. 

4. Determine the Tonal Value of the basic Spot Color [47]. All 100 color patches will be provided with the selected 

Tonal Value. This allows you to control with which Tonal Value the basic Spot Color is to be printed with the 

graded overprinting Spot Color. 

5. Under Number of reductions [48], determine how many Grid Charts you want to create with a modified Tonal 

Value of the Base Spot Color. Use this to create a series of Grid Charts with graded Tonal Values of the Base 

Spot Color and the overprinting gradations of the selected overprinting Spot Color. You can see how the 

individual Grid Charts look by simply scrolling over the navigation bar [50]. 

6. In Decrease by [49], determine how much the Tonal Value of the Base Spot Color is to be graded. The 

multiplication of the value of the number of reductions and the percentage value in Decrease by must be smaller 

than the Tonal Value of the Base Spot Color, otherwise the value for the Tonal Value would become smaller than 

NUll. A corresponding error message warns the user if invalid entries are made. 

7. Select Create [51] if you want to create the Grid Chart without sending it to the Printer. This can also be done 

later in the Color > Color Books & Grid Charts menu item. 

8. Select Next [52] if you want to jump to the next step Output Configuration. 
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Figure 15: The first step General when creating a Grid Chart of overprinting Spot Colors 

Step 2: Create Grid Chart of overprinting Spot Colors - Output Configuration 

1. In the Output Configuration step select on which Printer with which Output Configuration the Grid Chart(s) will 

be printed. 

• Printer [53] - select the target Printer, thus limiting the selection in the Substrate option already to the assigned 

Substrates for the Printer. 

• Substrate [54] - select the Substrate which is to be used, thus limiting the selection in the Color Policy option 

already to the available Color Policies for the Substrate. 

• Color Policy [55] - select the Color Policy which is to be used. If you know in advance which Color Policy you 

want to use for printing the Grid Chart, select the Color Policy by entering its ID in the selection menu. This 

procedure automatically selects the Printer and Substrate accordingly in the preceding options. With how 

many colors the Grid Chart will be printed is shown to the user by the visualization of the color channels [56]. 

• Destination folder [57] - select the folder to which the Grid Chart(s) will be rendered to the Printer. 

1. Select Create [58] if you want to create the Grid Chart(s) without sending it to the Printer. This can also be done 

later in the Color > Color Books & Grid Charts menu item. 

2. Select Next [59] if you want to jump to the next step Layout. 

Figure 16: The second step Output Configuration when creating a Grid Chart of overprinting Spot Colors 
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Step 3: Create Grid Chart of overprinting Spot Colors - Layout 

1. Determine in the Layout step how the Grid Charts should be arranged to be output at the Printer. 

• Impose Sheet size [60] - Select the size of the Impose to be created by either selecting the desired Substrate 

Definition or entering a user-defined Impose Sheet size. 

• Substrate Definition [61] - Select a desired Substrate Definition. This selection is only available if the Use 

Substrate Definition option is selected. 

• Width and Height [62] - Use this to define the size of the Impose Sheet. These options are only available if 

the Custom option has been selected. 

• Alignment [63] - Use this to define how the grid at Grid Charts should be aligned horizontally or vertically on 

the Impose Sheet. 

• Grid settings [64]- Define the grid in which Grid Charts are to be mounted and printed by specifying columns 

and rows. 

• Spacing [65] - Define the horizontal and vertical spacing between the individual Grid Charts. 

• Rotate [66] - Define the rotation in which Grid Charts are to be rotated. 

1. Select Create [67] if you want to create the grid chart without sending it to the Printer. This can also be done 

later in the Color > Color Books & Grid Charts menu item. 

2. Select Create and Send to Printer [68] to complete the creation process and output the grid chart to the Printer. 

Figure 17: The third step Layout when creating a Grid Chart of overprinting Spot Colors 
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More actions 

In addition to creating the Grid Charts, other options are available. These are: 

• Edit - pressing this button opens the Create dialog again. Settings that have already been made can be revised. 

Only the Spot Color itself may not be changed afterward. 

• Delete - using this option, selected Grid Charts can be removed from the system. This operation cannot be 

undone. 

• Send to Printer - pressing this button opens the Create dialog again. After going through the individual steps, the 

Grid Chart can be sent to the Printer. 

• Download - by clicking this button, the Grid Chart will be downloaded locally as a PDF file. 

Further information 

Further information on creating a Grid Chart of overprinting Spot Colors as well as detailed 

documentation on all parameters that can be encountered when creating the Grid Chart can be 

found in the Article Creating a Grid Chart of Overprinting Spot Colors. 
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2.4. Check-in Templates 

In this version, the options in the check-in profile have been further expanded. Furthermore, the availability of check-

in templates was provided system-wide. Find out in this section what new features and improvements have been 

implemented in this version. 

2.4.1. General and system settings 

In version 1.14.0, the area for managing check-in templates has been adapted to the newly implemented logic of 

working with templates only. Prior to 1.14.0, this area listed the two check-in profiles - Default Preflight and Fixup 

and Minimal Preflight and Fixups - as well as any user-defined check profiles. With version 1.14.0, on the one hand, 

the two existing check-in profiles have been removed and, on the other hand, the possibility to upload another user-

defined check-in profile has been removed. To ensure the same check-in behavior after an update, two check-in 

templates - Workflow Default Preflight and Workflow Minimal Preflight - are delivered by default and migrated 

accordingly after an update. 

With version 1.14.0, only one check-in profile is available to the user, which can be freely configured by the user. The 

settings made can then be saved by the user as a check-in template, thus creating the option of selecting Checks 

and Fixups on a product-specific basis during Check-in. 

The user can Create, Delete and Select the check-in template which is to be used as Default as follows. 

• The default check-in template is designated by the green Default [71] label. 

1. Navigate to the Administration > Settings menu. 

2. Switch to the Preflight / Fixup tab [69]. 

3. Manage the available Check-in Templates in the Check-in Preflight and Fixup Templates area [70]. After an 

update, at least the Workflow Default Preflight [72] and Workflow Minimal Preflight [72] check-in templates are 

Creating Check-in templates 

Please note that the possibility to configure your own check-in templates is not available in all 

product versions - e.g. Durst Print Workflow. If you are interested in this possibility, please contact 

the sales department. 

You can find out which Checks and which Fixups you can use for check-in in the Articles Checks for 

normalization and Fixups for normalization. 
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available. The functionality of both templates corresponds exactly to the previously available check-in profiles, 

which were available in Workflow versions before 1.14.0. 

• Add [75] - Clicking this button opens the dialog for creating and configuring new check-in templates. You can 

read more about this in the Article Dealing with Check-in templates. 

• Edit [76] - Check-in templates that have already been created can be edited using this function. The settings you 

have made will be overwritten. "Locked" check-in templates, which are provided in the system by default, cannot 

be saved over. However, you can use these check-in templates as the basis for your own check-in templates. 

• Delete [74] - Activating this button will delete selected check-in templates. The check-in templates supplied by 

the system cannot be deleted. Before deleting a check-in template, make sure that it is not already stored in 

other settings- e.g: Hotfolder or API requests. 

• Set as Default [73] - This menu contains the Set as Default function. To do this, select the desired check-in 

template to be used by default in the Workflow and call the function. You can see which check-in template is 

used by default by the green Default label [71]. 

Figure 18: The tab Preflight / Fixup of the menu Administration > Settings 
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2.4.2. Usage in "Force Print" 

From version 1.14.0 on, the user can select the desired Check-in Templates in the Force Print Job tab. This is 

available when in previous versions the Check-in profile was selected by default when uploading Print Items. 

Thereby it is possible to draw on product-specific Checks and Fixups when processing print data. Proceed as 

follows: 

1. Navigate to the menu Automation > Force Print. 

2. Configure the desired settings for the Force Print. 

3. Select the desired Check-in template [77] in Data Preparation. By default, the Check-in Template which was "set 

as Default" in Settings will be selected here. 

4. Select further settings in the dialog. 

5. Finish the process by selecting Create Production Job in the header. 

Figure 19: The settings of the menu Force Print Job with the possibility to select a Check-in Template 

Migration with version 1.14.0 

During the update to Workflow version 1.14.0, all "old" check-in check profiles - Default and custom - 

will be removed, so that only check-in templates provided by the system will exist. Make sure that 

these "old" check-in profiles are no longer used in the Workflow for example, in Hotfolder 

configurations. From this version on, use only check-in templates for the respective areas in the 

Workflow. 
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2.4.3. Usage in "Hotfolder" 

Whereas in previous versions a selected check-in profile was used by default when uploading Print Items, as of 

version 1.14.0 the user can select the desired check-in templates in the Process Parameters tab in the Hotfolder 

Setup dialog. Thus, to use them to access product-specific checks and Fixups when processing print data. Proceed 

as follows: 

1. Navigate to the Automation > Hotfolder menu. 

2. Create a new Hotfolder or edit an existing Hotfolder. 

3. Activate the Process Parameters tab. 

4. Select the desired entry in the Check-in template [78]. 

5. Proceed with the configuration in the Hotfolder setup dialog. 

Figure 20: The settings of the Process Parameter tab of the Hotfolder Setup dialog with the possibility to select the 

desired Check-in template 
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2.4.4. New Check-in Fixups 

With version 1.14.0, new Fixups are available in Check-in, allowing you to standardize the normalization of print data 

for production. The following new Fixups are available. 

Rename prohibited Spot Color Names 

Renaming prohibited Spot Color Names ensures in production that these Spot Colors are also correctly converted 

to the assigned Output Color Space. If the renaming wasn't carried out, these Spot Colors would only be printed in 

the pure Process Color available in the Printer. 

Deprecated Hotfolder configurations 

Make sure that all Hotfolder configurations have been changed to Check-in templates after updating 

to version 1.14.0. "Old check-in profiles" are no longer supported as of this version. Incompatible 

Hotfolder configurations can be recognized in the system status of the Workflow - for details click 

here. 
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This Fixup is disabled by default and should be enabled and configured in each custom Check-in Template. 

Figure 21: The settings area of the Fixup Rename prohibited Spot Color Names 

Set Spot Colors to "Overprint" 

Sets the overprint state for selected Spot Colors to "Overprint". Use this fixup to set all objects that use a Technical 

Color or Output as a Separation Color, such as Punch, Crease, Dieline, Kiss-cut, Thru-cut, or White, Varnish, etc., to 

Overprint. 

This Fixup is disabled by default and should be enabled and configured in each custom Check-in Template. 

Figure 22: The settings area of the Fixup Set Spot Colors to "Overprint" 
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Remove Empty Layers 

This Fixup removes empty layers from the Print Item. Empty layers are layers on the Print Item on which no object is 

present. 

This Fixup is disabled by default and should be enabled and configured in each custom Check-in Template. You 

should only deviate from this recommendation if you want to use empty layer names in the data preparation. 

Figure 23: The setting area of the Fixup Remove Empty Layers 

Enter only "standardized" Spot Colors 

As an administrator, you will certainly use the "Rename Spot Colors" fixup in any Check-in template to 

standardize unknown naming for Technical Colors as well as for White, Varnish, etc. for your 

operation. Since the "Set Spot Colors to Overprint" fixup is run after renaming Spot Color names, you 

only need to enter those Spot Colors you use in your operation in this Fixup. 
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Remove Hidden Layers 

This Fixup removes hidden layers, which are invisible but contain objects, from the Print Item. 

This Fixup is disabled by default and should be enabled and configured in each custom Check-in Template. You 

should only deviate from this recommendation if you want to use hidden layer names in the data preparation. 

Figure 24: The settings area of the Fixup Remove Hidden Layers 

2.4.5. New Check-in Checks 

With version 1.14.0, new checks are available in Check-in, allowing you to standardize the normalization of print 

data for production. The following new checks are available. 

Prohibited Spot Color Names in use 

In this version this check was renamed from Spot Color Name is the same as Process Color Name to Prohibited 

Spot Color Names in use and also extended. Thereby, you can add as many colors as you like. 

This Fixup is disabled by default and should be enabled and configured in each custom Check-in Template. You 

should only deviate from this recommendation if you want to use unused layer names in the data preparation. 

Figure 25: The settings area of the Check Prohibited Spot Color Names in use 
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Overprinting Spot Colors 

This check controls whether the overprinting status of the selected Spot Colors is set to "Overprint". Use this to 

check whether certain Spot Colors such as "Barcode" are set to knockout and thus do not show through objects 

behind them. 

The check is disabled by default and can be enabled and configured in custom check-in templates. 

Figure 26: The settings area of the check Overprinting Spot Colors 

Spot Colors in Knockout 

This check is used to check whether the overprinting status of the selected Spot Colors is set to "Knockout". Use it 

to check whether, for example, certain Technical Colors such as "Cut" are overprinting and thus objects behind them 

 show through. 
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The check is disabled by default and can be enabled and configured in custom check-in templates. You can bypass 

this check if you are executing the Fixup Set Spot Colors to "Overprint". 

Figure 27: The settings area of the check Spot Colors in Knockout 

2.5. Approval Reports 

As of this version, Approval Reports as well as project Print Itemations can be named automatically based on a 

defined naming scheme. In addition, filtering and sorting options have been implemented in the online Approval 

Portal. You can learn more about this in this section. 

2.5.1. Name of the Approval Report 

A system setting is available from this version for naming the release report. The project name and the file name 

can be freely defined. However, the setting can still be overwritten at any time when creating the report. 

How to configure the naming scheme for Approval Reports: 

1. Navigate to the Administration > Settings menu. 

2. Activate the General tab. 

3. In the Report Settings section, specify both naming conventions. 

• Project name [79]- Configure the desired project name for share reports by inserting the variable placeholders - 

by typing the @ -key - and static text. In the Create Approval Report dialog, this default value is used and can 

still be overwritten there. 

• File name [80] - Configure the desired file name for share reports by inserting the placeholders of the variables - 

by typing the @ -key - as well as static text. In the Create Approval Report dialog, this default value is used and 

can also be overwritten there. 
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Figure 28: The settings area Report Settings in the menu Administration > Settings > General 

The settings made for the project name and file name can still be overwritten when creating share reports. Proceed 

as follows: 

1. Select one or more Articles or Print Items in the list of Articles or Print Items of an Order. 

2. Activate Process > Create Approval Report. 

3. If necessary, overwrite the General Settings for the Project name [81] and File name [82] in the step. 

4. By hovering the Info icon [83], a current preview of the name is displayed. 

5. By activating the Refresh button, the preview of the name will be updated. 

Use of the project and file name 

The project name is used for... 

• ... the name of the multi-page PDF file, if several reports are generated as a multi-page PDF file 

• ... the name of the ZIP file, if several reports are generated as a ZIP file 

• ... the name of the e-mail link for releasing the reports in the release portal (if available in the e-mail 

template) 

• ... the name of the e-mail subject, if the release e-mail is sent 

• ... the Print Item in the header line in the release portal 

The file name is used for... 

• ... the file names in the ZIP file 

• ... individual release reports which are downloaded 

• ... the individual reports in the release portal 
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Figure 29: The Create Approval Portal dialog with the configuration of the Project and File Name 

2.5.2. Filter and Sort in Approval Portal 

As of this release, two additional filter and sorting options are available in the Release Portal. These are: 

• Filtering by and sorting based on the name of the Approval Report 

• Filtering by and sorting based on the status of the Approval Report 

Figure 30: The new Sort and Filter options in the Approval Portal 
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2.6. User-defined fields 

With version 1.14.0, the user-defined fields for Print Items and Articles have been merged to prevent conflicts when 

transferring user-defined fields to a Production Job. 

Previously, custom fields for Print Items and Articles could be created, managed, and used separately. This 

sometimes led to several problems e.g. that the values from the fields were not transferred correctly to a 

Production Job.  For this reason 

• the user-defined fields for Articles have been removed in this version. 

• Articles of user-defined fields of an Articles are transferred to a user-defined field of a Print Item during the 

update. 

• existing duplicates are removed. 

Migration of Custom Fields 

When installing the update, it is attempted to move the Custom Fields for Articles to the Print Item 

level. After that, the Article section will be removed and the custom fields of the Print Item will be 

unlocked for Articles. Under some circumstances, this migration can lead to data loss - related to 

Custom Fields. In this case, contact customer service. 
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2.7. Data Preparation 

With version 1.14.0, the conversion of Fixups to variable input options - these are marked with the V2 tag - has been 

further advanced in the Data Preparation environment. Furthermore, existing Fixups have been improved and new 

Fixups have been added. 

2.7.1. Values for selection lists in dynamic fields 

In many Fixups, selection lists that can also be dynamically filled with values from user-defined fields or via the API 

are available, among other things. If you want to know which value in a dynamic field has to be used for an entry in 

a selection list, proceed as follows: 

1. Open the Fixup which is to be used. 

2. Select the entry in the selection menu. In the example, the option Stretch border area as Image is to be used. 

3. Press the [84] icon, which allows you to enter a value (string) [85] in the selection list. 

4. At the right edge of the input field, there is the information icon. Clicking on the symbol opens a dialog in which 

you can read out the expected input values for the Print Item displayed in the dialog. In our example from the 

figure below, the value ImgStretchCorners  would thus have to be passed in order for the  Stretch border area 

as Image option to be applied in this Fixup. 

Figure 31: Left: Static selection of an option | Center: Entry of a dynamic value | Right: Value list which must be 

selected to choose an option 
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2.7.2. General and change to V2 

The change of Fixups to Fixups with variable input fields, which started with version 1.13.1, was continued in 

version 1.14.0. The list of affected Fixups is very long. All Fixups are listed below with a corresponding note about 

their new features. 

Make all Layers Visible 

Changes the state of visibility for all layers to visible. 

New features 

• Conversion of the XML file to v2. No functional or layout change. 

Figure 32: The new dialog of the Fixup Make all hidden layers 

Remove Page Boxes 

Removes Trim-, Bleed-, Crop- and ArtBox from the PDF. 

New features 

• Conversion of the XML file to v2. No functional or layout change. 

Figure 33: The new dialog of the Fixup Remove Page Boxes 
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Flatten Layers 

All objects on layers that are currently invisible are discarded and all layers (which are visible) are flattened 

(removed from the document) 

New features 

• Conversion of the XML file to v2. No functional or layout change. 

Figure 34: The new dialog of the Fixup Flatten Layers 

Create Bleed on Irregular Shape 

The Bleed is created by repeating pixels around an irregular shape. The Bleed is generated as a 300 dpi CMYK 

image and created in the background. You can determine which pixel is used for the repetition by specifying the 

value in "Starting Point Pixel Repetition". If Spot Colors are used in the Print Item, a color shift in the output for the 

bleed cannot be excluded. 

User Manual

Page 42Release – 1.14.0 (Major Version)



New features 

• An additional possibility to save templates 

Figure 35: The two tabs Basic Settings and Advanced of the Fixup Create Bleed on Irregular Shape 

Add Caption 

Adds a caption - the selected text - to the selected edges in the specified position, font, size, and color. In addition, 

this caption can be given its own Dieline in advanced settings. 

New features 

• Switch to the dynamic input field for most options 

• Using the new layout elements 

Figure 36: The two tabs Basic Settings and Advanced of the Add Caption Fixup 
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Remove Layers and crop to the visible area 

Removes the selected layers including all objects on them and crops all pages to the visible area. You can also 

decide whether Crop Marks should be taken into account and which safety margin should be retained. 

New features 

• A changeover to a dynamic input field for the Safety Margin option 

• Using the new layout elements 

Figure 37: The new dialog of the Fixup Remove Layers and crop to the visible area 
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Create Ellipse/Rectangle as Technical Shape 

Creates a geometric shape based on the selected position and specified size. Use this Fixup to create a circle-

shaped Dieline originating from the center of the artwork. 

New features 

• A changeover to a dynamic input field for most options 

• Using the new layout elements 

Figure 38: The two tabs Basic Settings and Advanced of the Fixup Ellipse/Rechteck als technische Form erzeugen 
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Embed missing Fonts 

Searches the local Server font folder for missing fonts and attempts to embed them. 

New features 

• Conversion of the XML file to v2. No functional or layout change. 

Figure 39: The new dialog of the Fixup Fehlende Schriften einbetten 
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Add Pole Pockets 

Adds a hem to the selected edge of the Print Item to the front. The Print Item on the back is mirrored to the Print 

Item on the front. You can define which area of the backside should overlap on the front side up to the maximum 

size of the hem. 

New features 

• A changeover to a dynamic input field for most options 

• Using the new layout elements 

Figure 40: The new dialog of the Fixup Add Pole Pockets 

Render Comments 

Comments (Annotations in the PDF) that are in the print area are converted into printable objects. The RGB objects 

are assigned the sRGB source profile and missing fonts are embedded. 

New features 

• Conversion of the XML file to v2. No functional or layout change. 

Figure 41: The new dialog of the Fixup Render Comments 
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Remove Empty Pages 

Removes all empty pages from the document. 

New features 

• Conversion of the XML file to v2. No functional or layout change. 

Figure 42: The new dialog of the Fixup Remove Empty Pages 

Remove unused and/or hidden Layers 

Removes unused or hidden layers in the Print Item. Use this Fixup to reduce the content of the Artwork of all used 

and visible layers. 

New features 

• A changeover to XML v2 
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• Using the new layout elements 

Figure 43: The new dialog of the Fixup Remove unused and/or hidden Layers 

Convert Registration Color 

Converts the Registration Color either to 100% Black or to a Spot Color called "Separation Black". Note that the Spot 

Color "Black" is also converted to "Separation Black". 

New features 

• Conversion of the XML file to v2. No functional or layout change. 

Figure 44: The new dialog of the Fixup Convert Registration Color 
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Assign Source Profile for RGB objects 

Assign an ICC Profile for RGB objects that do not have a source profile (DeviceRGB). This allows you to assign a 

source profile to an RGB object that differs from the working color space. 

New features 

• A changeover to a dynamic input field for most options 

• Using the new layout elements 

Figure 45: The new dialog of the Fixup Assign Source Profile for RGB objects 
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Redraw Dieline of the TrimBox 

Deletes the existing Dieline and adds a new Dieline based on the position of the original Dieline. 

New features 

• A changeover to a dynamic input field for most options 

• Using the new layout elements 

Figure 46: The two tabs Basic Settings and Advanced of the Fixup Redraw Dieline of the TrimBox 
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Add a DieLine to the ImageBox 

Adds an overprinting Dieline in the size of the selected production frame - ImageBox or ImageBox + Bleed - and 

optionally an additional overprinting Dieline in the defined Offset. The Dieline is assigned to the Processing Steps 

Group and Type according to ISO 19593-1. 

New features 

• Using the new layout elements 

Figure 47: The new dialog of the Fixup Add a DieLine to the ImageBox 
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Add a DieLine for Irregular Shapes 

Adds an overprinting DieLine based on an irregular shape and optionally adds a second overprinted Dieline in the 

defined Offset. The Dieline is assigned to the Processing Steps Group and Type according to ISO 19593-1. 

New features 

• Using the new layout elements 

Figure 48: The new dialog of the Fixup Add a DieLine for Irregular Shapes 
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Derive a Dieline from Spot Color 

Creates a Dieline by tracing Spot Color objects. On the one hand, this Fixup can be used to offset an existing Dieline, 

on the other hand, to derive a Dieline from Spot Color objects. This converts a non-path Dieline to a Dieline as a 

path. 

New features 

• A changeover to a dynamic input field for most options 

• Using the new layout elements 

Figure 49: The two tabs Basic Settings and Advanced of the Fixup Derive a Dieline from Spot Color 
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Add Crop Marks 

Adds Crop Marks and/or Bleed marks. Crop Marks are set to the TrimBox and Bleed Marks are set to the BleedBox. 

New features 

• A changeover to a dynamic input field for most options 

• Using the new layout elements 

Figure 50: The new dialog of the Fixup Add Crop Marks 
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Convert Fonts to Outlines 

Converts Embedded Fonts to Outlines (Missing Glyphs Are Ignored). 

New features 

• Conversion of the XML file to v2. No functional or layout change. 

Figure 51: The new dialog of the Fixup Convert Fonts to Outlines 
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Convert Page Content to an Image 

Converts page content into a pixel image using the selected color space. Elements such as Text, Spot Color or Text 

and Spot Color, can be excluded from being converted, for example, to accept unwanted color shifts when 

converting a Spot Color. To convert a single page, enter the desired page number using the Pages input. To convert 

a page range, enter both page numbers separated by a hyphen (e.g.: 2-5) in the Pages input. 

New features 

• A changeover to a dynamic input field for most options 

• Using the new layout elements 

Figure 52: The new dialog of the Fixup Seiteninhalt in Bild konvertieren 

Remove Scale Factor 

Removes Page Scale Factor (User Units). 

New features 

• Conversion of the XML file to v2. No functional or layout change. 

Figure 53: The new dialog of the Fixup Remove Scale Factor 
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Mirror the Print Item on the Short Edge 

Mirrors the print item on the short edge. The length of the long edge will be doubled. 

New features 

• Conversion of the XML file to v2. No functional or layout change. 

Figure 54: The new dialog of the Fixup Mirror the Print Item on the Short Edge 

Mirror the Print Item on the Long Edge 

Mirrors the print item on the long edge. The length of the short edge will be doubled. 

New features 

• Conversion of the XML file to v2. No functional or layout change. 

Figure 55: The new dialog of the Fixup Mirror the Print Item on the Long Edge 
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Change "Overprint" to "Multiply" 

Replaces the overprint status "Overprint" to "Multiply" to reduce the RIP time. If the appearance changes too much, 

the fixup will be canceled. Set the maximum deviation in the "Allowed Deviation" option. 

New features 

• Conversion of the XML file to v2. No functional or layout change. 

• A changeover to a dynamic input field 

Figure 56: The new dialog of the Fixup Change "Overprint" to "Multiply" 
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Remove Existing Bleed 

Page content outside the TrimBox will be cropped. MediaBox, CropBox and BleedBox are set to the TrimBox 

New features 

• Conversion of the XML file to v2. No functional or layout change. 

Figure 57: The new dialog of the Fixup Remove Existing Bleed 

Reinforce White Elements 

Enlarges selected white objects such as lines (strokes), vectors and/or texts by the entered value by changing the 

line width for the object. 

New features 

• A changeover to a dynamic input field for most options 

• Using the new layout elements 

Figure 58: The new dialog of the Fixup Reinforce White Elements 
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2.7.3. New Fixups 

For version 1.14.0 a new Fixups has been developed, which allows to correct CMYK colors in the print file. 

CMYK Color Correction 

Corrects the CMYK values based on the values stored in the curve for each color channel. If RGB data and Spot 

Colors are also to be corrected, you must activate the corresponding options. Attention: Spot Colors and RGB data 

are converted to CMYK beforehand! 

Figure 59: The new dialog of the Fixup CMYK Color Correction 
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The following functions are available in this Fixup: 

• Templates [87]: Select from the available predefined curves or save your settings for a Color Correction that you 

want to apply to the print file. 

• Apply to [88]: Use this to determine whether you want to apply the Color Correction to all objects or only to 

images, vectors, text, or text and vectors. 

• Convert Spot Colors to CMYK [89]: Use this to determine whether Spot Colors are converted to CMYK 

beforehand so that the Color Correction is also applied to Spot Colors. 

• Convert RGB objects to CMYK [90]: Use this to determine whether RGB objects are converted to CMYK 

beforehand so that the Color Correction is also applied to RGB objects. 

• Color channel [91]: Select the color channel you want to correct from the list. 

• Show all color channels [92]: Use this to determine whether only the currently selected color channel should be 

displayed or whether all color channels should be displayed with the curves. 

• Output [93]: Enter the output value to be corrected to the input value. 

• Straight/Curves [94]: Use this to determine whether the curve is to be constructed from corner points only or 

whether the curve is to be constructed from Bezier curves. 

• Add [95]: Use this to insert a new point on the curve, allowing you to add the corresponding corrected output 

value to a new input value. 
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2.7.4. Improvement of existing Fixups 

For version 1.14.0 some already existing Fixups have been extended in the range of functions. In the following 

Fixups new functions were added or the possibility was created to save the settings of the Fixup dialog as a 

template. 

Remove Print Marks 

Removes all Print Marks (Bleed Marks, Crop Marks as well as Color Control Strips) that lie completely outside the 

TrimBox. The presence of a TrimBox or a BleedBox is assumed. 

New features 

• A changeover to dynamic input fields 

• Using the new layout elements 

• Print Marks that protrude into the Bleed will still be deleted 

• Creation of the possibility to set the BleedBox by the entered offset to the TrimBox 

• Creation of the possibility to save settings in the dialog as a template. 

Figure 60: The new dialog of the Fixup Remove Print Marks 
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Create Spot Color Separation depending on Total Ink Coverage 

Creates a separation using the selected Spot Color based on the current page content, depending on the total ink 

coverage. The higher the total ink coverage, the lower the percentage of ink coverage contained in the separation. 

Use this Fixup, for example, to create a white channel or any other System-wide Defined Spot Color, dependent on 

the Total Ink Coverage in order to reduce ink costs or to reduce the ink coverage. 

New features 

• A changeover to dynamic input fields 

• Using the new layout elements 

• Possibility to save settings in the dialog as a template in order to be able to select them again at a later time 

• Possibility to define the color tone as a curve depending on the total color application 

Figure 61: The two tabs Basic Settings and Advanced of the Fixup Create Spot Color Separation depending on Total 

Ink Coverage 
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Add a DieLine from the Center 

Adds a DieLine using a specific width and height from the center of the Print Item and optionally a second 

overprinting Dieline in the defined Offset. The DieLines are assigned to the Processing Steps Group and Type 

according to ISO 19593-1. 

New features 

• Using the new layout elements 

• The creation of rounded corners by entering a corner radius 

Figure 62: The new dialog of the Fixup Add a DieLine from the Center 

Create the possibility to save settings in "Templates" 

For the following Fixups, the possibility to save settings of the Fixups dialog as a user-defined template has been 

created. The following Fixups are affected: 

• Clip Print Item with Additional Bleed 

• Resize TrimBox and set Bleed 

• Add a DieLine to the ImageBox 

• Set TrimBox to the Dieline 
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• Create Bleed on Irregular Shape 

• Rotate and/or Mirror Page 

• Set Scale Factor 

• Map CMYK Values from Vector Objects to a Spot Color 

• Redye CMYK-Objects 

• Convert Pure Black to Rich Black 

• Convert Black Text Objects to Rich Black 

• Change Tonal Value for Spot Color 

• Fill PageBox with Spot Color 

• Add a DieLine for Irregular Shapes 

• Add a DieLine from the Center 

• Add a DieLine to the ImageBox 

2.8. SDK versions 

With version 1.14.0 two new SDK versions are available, in which some improvements and errors on the part of the 

manufacturers were repaired. The following SDK versions have been updated in this release: 

• Callas Software pdfToolBox SDK version 14.0 

• Color Logic CrossXColor SDK version 1.20.1.44435 

• Java Update to Java 17 

3. Improvements 

The following improvements have also been implemented in version 1.14.0. 

3.1. "Variable Data" tab 

Also in this version, more changes have been made in the "Variable data" tab. Read in this section which 

adjustments are involved. 

3.1.1. Display of Errors and Warnings 

Warnings and errors, which may be displayed in the VDP Editor, are also displayed in the Variable Data tab as of this 

version so that they are also clearly visible outside the VDP Editor. This makes it possible to intervene in the data 

before the order is further processed. 
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Figure 63: The display of Errors and Warnings in the Variable Data tab 

3.1.2. Warning when importing VDP settings 

When importing VDP settings, it is checked whether the dimensions and coordination of the ImageBox of the 

current Print Item or Article match the respective dimensions and coordinates of the original Article or Print Item. If 

the dimensions or coordinates do not match, a warning is displayed in the Import dialog. 

The import can still be carried out. In this case, the user must make manual adjustments and perform a thorough 

check. 

Figure 64: One of the warnings when importing VDP settings 
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3.2. Output Template and Simulation 

In this version, the user interface for creating a Simulation or a Proof has been adapted to make the selection more 

intuitive for the user. From this version on, proceed as follows to create a simulation or a proof print. 

1. Open a Production Job. 

2. Activate the Output Configurations tab. 

3. Open the Simulation area. 

• Select No Simulation if no simulation and no proof print are desired. 

• Select Proof (absolute colorimetric) and the desired version - Workflow Color Policies or Working or Output Color 

Space - if the simulation is to be absolutely colorimetric. 

• Select Simulation (relative colorimetric) and the desired version -  Workflow Color Policies or Working or Output 

Color Space - if the simulation is to be performed relatively colorimetrically. 

Figure 65: The settings area Simulation of an Output Configuration 
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3.3. Filter options for the "Print Statistics" tab 

As of this version, four additional filter options are available in the Print Statistics tab of a Production Job. These 

are: 

• X-resolution from - define the minimum value of the X-resolution of a print configuration. 

• X-resolution to - define the maximum value of the X-resolution of a print configuration 

• Y-resolution from - define the minimum value of the Y-resolution of a print configuration 

• Y-resolution to - define the maximum value of the Y-resolution of a print configuration 

Figure 66: New filter options in the Print Statistics tab 
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3.4. Permissions 

In the course of the development of version 1.14.0, some permissions have been adjusted. The following 

adjustments were made: 

• Impose Editor permissions - a standalone permission node was added and all related permissions were moved 

into it. Previously, Impose Editor permissions were located in Global Role Permissions. 

• Permissions for PDF Editor - a separate permission node has been added and all related permissions have been 

moved into it. Previously, the PDF Editor permissions were located in the Print Item Role Permissions. 

• Permissions to create and edit Check-in Templates - the permission for this can be found in Administration > 

Settings > "Preflight / Fixup" tab > Create and edit Check-in Preflight and Fixup templates. 

Custom check-in templates are available in the following Workflow packages as of version 1.14.0: 

• Workflow Print + 

• Workflow Label 

• Workflow Label + 

• Prepress Tools (add-on to Workflow Print) 

• Workflow Prepress 

Figure 67: The settings area Role Permissions with its new structure for the Impose Editor and the PDF Editor 
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3.5. Rest API 

With version 1.14.0 two new functions are available. 

3.5.1. Check-in Templates 

It is possible to define the underlying Check-in and Fixup template at Motif level. This is possible both for Articles 

and for Print Items within Orders and Production Jobs. The following property is now available for this purpose. 

"checkinTemplateGuid": ""   followed by the corresponding Guid. 

Example based on the creation of an Article 

POST /api/v1/articles/create 

{ 

                "name": "Article with checkinTemplate", 

                "checkinTemplateGuid": "47e8e6c4-2ebc-412f-b427-e6393e66b67e", 

                "pdfFileLink": { 

        "uri": "https://path.to/file/document.pdf" 

                } 
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} 

 Click to copy 

3.5.2. Overwrite dynamic variables in Fixups 

Applying Fixups and Fixup Chains in APIv2, with the possibility to overwrite existing variables in Fixup Chains. 

POST /pms/api/v2/workflow/execute/apply-fixup 

{ 

                "automationKey": "ADD_DIELINE_FROM_CENTER", 

                "entityId": 8182, 

                "parameter": { 

        "ADD_DIELINE_FROM_CENTER": true, 

                        "VERTICAL_OFFSET": 11, 

                        "VAR_NAME_Horizontal_Offset": 75, 

                        "VAR_NAME_Width": 47, 

                        "VAR_NAME_Height": 33 

                } 

} 

 Click to copy 
POST/pms/api/v2/workflow/execute/apply-fixup-chain 

{ 

                "entityId": 2353, 

                "fixupChainId": 17, 

                "parameter": [ 

        { 

                                        "automationKey": "ROTATE_PAGE_CONTENT", 

                                        "executionOrder": 0, 

                                        "parameter": { 

                                                        "VAR_NAME_DO_LEGACY_V1_KFPX_ROTATE_PAGE_CONTENT": true, 

                                                        "VAR_NAME_Rotation": 270, 

                                                        "VAR_NAME_Direction": "Clock", 

                                                        "VAR_NAME_Offset_Horizontal": 25, 

                                                        "VAR_NAME_Offset_Vertical": 30, 

                                                        "VAR_NAME_Relative_To": "Center", 

                                                        "VAR_NAME_Pagebox": "Trimbox", 

                                                        "VAR_NAME_Enlarge_Pagebox": true 
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                                        } 

                }, 

                {       "automationKey": "CREATE_BLEED_BY_SCALING", 

                                        "executionOrder": 1, 

                                        "parameter": { 

                                                        "VAR_NAME_DO_FIXUP_CREATE_BLEED_BY_SCALING": true, 

                                                        "VAR_NAME_Create_Bleed_Scale": 1.5, 

                                                        "VAR_NAME_Maximal_Distortion": 99 

                                        } 

        } 

    ] 

} 

 Click to copy 

3.6. Small Improvements 

In version 1.14.0 of the Workflow some other minor improvements are offered - these are: 

Examples for the content of a Barcode 

Many Barcodes are subject to specific criteria on how and what content can be used to generate the Barcode 

correctly. Until now, only the Adobe Illustrator plug-in for variable data provided helpful examples of valid barcode 

content. 

As of this release, examples of valid barcode content are displayed in the Impose Editor and also in the VDP Editor. 

Figure 68: Representation of a valid content for the selected Type 
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Remove sheet duplicates with "Flip-Flop" 

From this version on, the option Rotate every second page by 180 and Apply to will be deactivated in the Send to 

Printer dialog in the Size tab. This happens only if in the Nesting Imposition mode, the option Remove sheet 

duplicates in Nesting was activated for multi-page nestings. The reason is, that these two options do not make 

sense together. 

Randomly distributed Serial Numbers 

Starting from this version, the randomly distributed serial numbers are newly generated and randomly distributed 

each time the option is disabled and enabled. 

Figure 69: The settings area Content with selected Date Source "Serial Number" 

4. Fixed Bugs 

The following errors (bugs) could be fixed with this release. 
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4.1. Workflow 

XML Hotfolder: The number of copies of the Print Item was not correctly applied to the Production Job if the 

Production Job was not imposed. This error has been fixed. 

Download Article or Print Item: When downloading a Print Item or Article from Workflow, the internal document 

name was used for the file. As of this version, the Print Item or Article name is used. 

Hotfolder: In some cases the default target directory of the Printer was used when sending to the Printer instead of 

the target directory of the Hotfolder. The error could be fixed. 

Reprofiling: The tolerance value for "Violet" was defined at ∆00 3.0. This has been corrected in this version and is 

now ∆00 2.5 

Force Print in Italian: When creating a Force Print with the Italian language set, a line break was included in the 

Production Job name. This line break has been removed. 

Split TAU VDP job: When splitting VDP Production Jobs into individual jobs in the Send to Printer dialog, individual 

pages were sometimes not rendered. This error has been fixed. 

Transmitted light measurement with i1Pro3 Plus: An error occurred during the transmitted light measurement with 

the "i1Pro3 Plus" measuring device, which could be corrected. 

User-defined fields: Underscores "_" may no longer be used for the unique key of user-defined fields. 

Sending multi-page documents: When sending multi-page documents to the Printer, ZuniComm crashed in some 

cases when only parts of the pages were sent to the Printer. The error has been fixed. 

Fixup "Add Pole Pocket": The technical colors were mirrored as CMYK values. This error has been fixed. 

Preview in Article list: Sometimes wrong or not corresponding preview images were displayed for Articles. The 

error has been fixed. 

Primer Process Color: "Primer" was previously listed among the licensed process colors. A "Primer" process color 

could thus only be selected if the "Additional Process Colors" add-on package was licensed. The error has been 

corrected. "Primer" is available for all licenses. 

Third-party Printer: "White" could not be sent correctly to the third-party Printer when "White" was renamed. 

Third-party Printer - HP Latex 800W: "White" could not be rendered or sent correctly. The error has been fixed. 

Imposition in the Send to Printer dialog: When applying the Imposition in the Send to Printer dialog, the settings of 

the Imposition Sheet and Print Item templates were not applied. This error has been corrected. 
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Routines - CRON expressions: The CRON expressions for routines did not match. In the ToolTips different CRON 

expressions were displayed than in the Edit dialog. The behavior was adjusted. 

CTV Linearization: CTV Linearization could only be selected when a G7 linearization chart was printed. The error 

has been fixed. 

4.2. Impose Editor 

Tiling: Added grommets were only visible in Tile View. They were hidden in the Overall View. The behavior has been 

adjusted. 

Custom Tiling - Absolute: The "Auto" option had no effect. The behavior has been adjusted accordingly. 

Save Tiling: In rare cases, ZuniComm crashed when saving multiple tiling jobs in a row. The problem was fixed by a 

3rd-party update. Furthermore, the error was not displayed in the user interface. 

Page numbering labels: For variable data Production Jobs, correct page numbering could not be generated using 

labels. The error has been fixed. 

Print Item Templates: The colors of the backside of a Print Item were not saved correctly. The error has been fixed. 

Serial number - various problems: On the one hand leading "zeros" were automatically removed and on the other 

hand serial numbers with more than 16 digits were automatically truncated. Both errors have been fixed. 

4.3. VDP-Editor 

Export/import VDP settings: When importing VDP settings, serial number settings were not imported correctly. The 

error has been fixed. 

Barcode content - truncate string: When closing and reopening the VDP Editor, the settings for truncating the 

character string - e.g. for the content of a variable barcode - were reset. This error has been fixed. 

Path Tool: By default, the stroke of the Path Tool was thicker than that of other Object Creation Tools. This error has 

been corrected. 

Variable text - Fit Font Size: The "Fit Font Size" option had no effect when a text indent was defined. The bug has 

been fixed. 

CSV - First line is header: If the option "First line is header line" was deactivated, then the VDP order could no longer 

be imposed. Furthermore, the view of the CSV file was displayed incorrectly. The bug has been fixed. 
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5. Hot-Fixes 

The name for the December 31, 2022 release was "DW Build 1.14.0.(739)". The following hotfixes were fixed in the 

following subversions: 

DW Version 1.14.0.(752) 

Split Pages: Pages could not be split anymore, when a Production Job has already been created out from an Order. 

Barbieri Measurement Devices: A wrong SDK-Version has shown the measurement error, that all "Lab values are 

zero". 

„White“ in VDP Jobs: In some cases, the job crashed, when „White“ was used in the static part of a VDP job. 

Production Job State: The state for each Print Item was not set correctly when all Print Items were rendered to 

printer. 

TAU / VDP / JDF: In some cases, the histogram was not written into the TAU JDF. 

Printer-Substrate-Mapping: Manually linked Substrate Definitions to a printer were not migrated correctly. 

Check-in Template: Corrections were done for „Overprint Spot Colors“ and „Remove Empty Layers“. 

Spartanics Cutter + Multipage Document: Error „name duplicates found…“ was fixed. 

PrintFactory Migration: Correction handling of PrintFactory-Migrations, when PrintFactory is not started. 

Vutek Varbrifu: Jobs could not be rendered anymore. 

Vanguard Job Ink Usage: For Vanguard Jobs, now there is again an Ink Usage when the jobs were rendered to 

printer. 

Permissions for Check-in Templates: Corrections of permissions handling for custom Check-in Templates 

(Workflow and Workflow+) 

DW Version 1.14.0.(762) 

Data Preparation – Rotate and/or Mirror Page: Applying the Fixup ended with the error »Analyzing the PTB-profile 

failed, please contact support«. This bug has been fixed. 

PrintFactory Migration: Improvement handling of PrintFactory-Migrations, when PrintFactory is not started. 
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Check-in Templates: It was not possible anymore to edit and save a Check-in Template, when just the Name was 

modified. 
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